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Summary 

Objectives 

The objective of this document is to describe the aim of EDGE, how to use it and the main 

concepts behind it. 
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1. Introduction 

This document describes the EDGE CAD editor, the context and the concepts behind its con-

ception, as well as its use.   

Reference documents 

[RD1] GDML Web page, http://gdml.web.cern.ch/GDML/ 

[RD2] Geant4 Web page, https://geant4.web.cern.ch/geant4/ 

[RD3] SpaceSuite Web site, www.space-suite.com 

[RD4] Santin G. et al., ẮGRAS: A General-Purpose 3-D Modular Simulation Tool for Space Environment 

Effects Analysisắ, IEEE Trans. Nucl. Sci., Vol. 52, No. 6, December 2005 

[RD5] Jeanty-Ruard B. et al, ẮAdvanced CAD Tool and experimental integration of GRAS/Geant4 for 

internal charging analysis in SPISắ, Proceedings, 14th Spacecraft Charging Technology Conference, 

ESA/ESTEC, Noordwijk, NL, 04-08 APRIL 2016 

[RD6] Keridwen open-source IME Web site, www.keridwen.org 

[RD7] SPINE community Web site, www.spis.org 

[RD8] EDGE project Web page, http://www.space-suite.com/edge 

[RD9] GDML USERẫS GUIDE; Version 2.7; http://gdml.web.cern.ch/GDML/doc/GDMLmanual.pdf 

 Acronyms and abbreviations 

¶ B-Rep: Boundary Representation 

¶ CAD: Computer Assisted Design 

¶ CSG: Constructive Solid Geometry 

¶ EDGE: ExtendeD Gdml Editor 

¶ GDML: Geometry Description Mark-up Language 

¶ GUI: Graphical User Interface 

¶ IME: Integrated Modelling Environment 

¶ STL: STereo-Lithography 

¶ UNV: Universal File Format 

¶ XML: Extensive Markup Language 

http://gdml.web.cern.ch/GDML/
https://geant4.web.cern.ch/geant4/
http://www.spis-services.eu/
http://www.keridwen.org/
http://www.spis.org/
http://www.space-suite.com/edge
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2. EDGE objectives 

EDGE Ầ for ExtendeD Gdml Editor Ầ is an easy-to-use GDML-based CAD editor. It provides 

a powerful and flexible CSG model fully compliant with the GDML CAD format [RD1], used by 

numerous particle-matter interactions analysis tools based on the Geant4 library [RD2]. EDGE 

provides also various import/export capabilities from/to B-Rep based CAD formats.  

EDGE has been developed by Artenum in the frame of its internal R&D activities and is avail-

able through several of its commercial services offers, like SpaceSuite [RD3].  

2.1. About GDML 

Based on XML syntax, the Geometry Description Markup Language (GDML) is the reference 

language used to describe geometrical models (i.e. CAD models) for radiation modelling tools 

like Geant4 [RD2], ESA/GRAS [RD4] or SPIS-IC [RD5]. GDML is based on a rich CSG ap-

proach and can be used to create complex and realistic geometrical systems to be used for 

various purposes. 

As an XML-based language, it can be fairly well read by humans and it is quite simple to parse 

it. However, one of its limits is that it is difficult to visualise what a GDML file is going to produce 

just by looking at it in a tailored sense, i.e. as a 3D geometrical system. Although some viewers 

or editors exist, only a few of them are publicly available, and they are not user-friendly or 

incomplete. Moreover, most GDML editors so far cannot handle the depth hierarchy used in 

GDML. 

Therefore, Artenum decided to develop a GDML editor based on the IME Keridwen [RD6]. Its 

aim is to propose a simple-to-use, cross-platform editor with good capacities of visualization.  

2.2. Caution and limit of warranties  

The present document is intended to be a simple User Manual (UM) to help the user to use 

EDGE in basic mode to create CAD modelling. This document does not attempt to provide to 

the future EDGE user the whole expertise and knowledge needed to create a correct CAD 

modelling. The final confidence in the relevance and accuracy of the CAD model depends on 

the user expertise and remains his responsibility.  

FOR THIS REASON, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT 

PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING, 

THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS 

IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUD-

ING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 

FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND 

PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE 

DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR 

https://geant4.web.cern.ch/geant4/
https://geant4.web.cern.ch/geant4/
http://space-env.esa.int/index.php/geant4-radiation-analysis-for-space.html
http://space-env.esa.int/index.php/geant4-radiation-analysis-for-space.html
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CORRECTION. For an improved handling of the key concept addressed by EDGE, we strongly 

recommend to contact SpaceSuite. 

NB: for further information, please contact the SpaceSuite team on http://www.space-suite.com or at 

contact@space-suite.com. 

2.3. Main functionalities 

EDGE can either create or load a complete GDML model. In both cases, the user can modify 

the properties of all the shapes or add new shapes. Moreover, shapes also have position and 

orientation properties that allow placing them correctly. To facilitate the work for the user, po-

sition and orientation can be applied to several objects at the same time. EDGE handles com-

plex hierarchies with several levels of depth.  

EDGE also allows editing and attributing material properties to each shape individually. At any 

time, the user can see the results of his work thanks to the real-time 3D. 

After editing his file, the user can save the result back to GDML but he can also export it to the 

B-Rep .geo format (the file format of Gmsh)1.  

2.4. Supported formats 

2.4.1. Import 

EDGE support natively the GDML format in reading and writing, but is also able to import 

numerous B-Rep CAD formats like Gmshẫs geo or STEP-AP 203/214 and tessellated solids in 

STL or UNV files. These import/export capabilities open interoperability bridges with other CAD 

tools and multi-physics simulation software. 

  

Figure 1: Example of imported STEP-AP model inside EDGE 

                                                
1 http://geuz.org/gmsh/ 

http://www.space-suite.com/
mailto:contact@space-suite.com
http://geuz.org/gmsh/
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2.4.2. Export and CSG-to-B-Rep decomposition 

EDGE is able to convert GDML models into an equivalent Gmshẫs geo file, fully compliant with 

tailored applications like SPIS [RD7]. This conversion is not done by tessellation but by a 

proper CSG to B-Rep decomposition with the view in Gmsh (on the top of Figure 2) of a model 

initially defined in EDGE (on the bottom of Figure 2). 

   

Figure 2: CSG to B-Rep decomposition of a GDML model defined in EDGE (left)  

visualized in Gmsh (right) 
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3. Using EDGE 

3.1. Supported platforms  

Currently, EDGE can be used on most 64bits Linux platforms, Microsoft Windows-7-8-10 

32/64bits and OSX/MacOS 10.10.5 and higher 64bits.  

3.2. Starting Edge 

The application as well as the present User Manual can be downloaded from the SpaceSuite 

Web page [RD8].   

Once downloaded, the zip file containing the EDGE snapshot has to be extracted on the ma-

chine where it will be used on to ensure that the software is executable.  

NB: on Windows systems, the native unzipping method may encounter issues when unzipping EDGE. 

You may want to use third-party application to avoid issues. The unzip has been successfully tested 

with the 7Zip application. 

i. Linux  

Depending on your precise Linux distribution, double-clicking on the Edge.sh file may launch 

the application correctly (see below for more details on Gnome environments).   

To start the application, it is also possible to open a terminal and just execute ./ Edge.sh  in 

the application directory. It is then possible to indicate launching options, see the Command-

line launching options paragraph below. 

NB: on recent Linux distributions with Gnome, double-clicking on the Edge.sh displays the content of 

the file instead of launching it. You can modify this behaviour by going to the file manager preferences 

and changing the way executable files are handled. 

ii. MacOS 

To start the application, you need to open a terminal and execute the Edge.sh file. It is possible 

to indicate launching options, see the Command-line launching options paragraph below. 

iii. Windows 

Double-clinking on the Edge.bat  will launch the application. To use more advanced launching 

options, you can open a command invite and type Edge.bat . Options can be provided, see 

the Command-line launching options paragraph below  

For compatibility with all Windows systems, it is not possible to launch several EDGE at the 

same time on Windows. If you want to be able to launch several instances, you need to edit 

the EDGE.bat file and test if this function works on your system. Once the file is opened in your 

favourite text editor look for the following part: 

http://www.space-suite.com/edge
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set NOW=1 

and replace it with the following content (on one line, without line-break): 

set NOW=%date:~ - 4,4%%date:~ - 7,2%%date:~ - 10,2%%FormatedTime:~ - 11,2%%For-

matedTime:~ - 8,2%%FormatedTime:~ - 5,2%%FormatedTime:~ - 2,2% 

Save the modification and relaunch EDGE. If EDGE starts, you will be able to launch several 

instances of your software. If not, please revert the modification to be able to use EDGE: your 

system does not support launching several instances by using the automatic date computation 

mechanism. 

iv. Command-line launching options 

It is possible to use options to launch EDGE. The options can be added (one at a time) after 

the launching command. To know all the available options, the option ấh can be used (such 

as ./Edge.sh  - h or Edge.bat - h).  

- f path/to/gdml/file.gdml  

This option enables loading the given file at the same time than the application. 

3.3. EDGE Main Window 

The GUI of EDGE is intuitive and based on the concept of Ắperspectivesắ, where the modelled 

system can be viewed and handled from different approach or points of view, like the edition 

of the geometrical model, the definition of material properties or the assignment of these ma-

terials to their correct geometric shape. 

As shows the Figure 3, some elements of the graphical interface are common for all perspec-

tives:  

¶  Main Menu corresponds to main control menu of the application.  

¶  General Toolbar presents shortcut buttons to open and save (on the left) a file and 

also allows switching from a perspective to another (on the right). This toolbar also 

grants access to the preferences panel.  

  Ẹ  
  

Figure 3: Main elements of EDGE window (here in the geometry perspective)  

1 

2 

 
 

1 

2 
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3.3.1. Main Menu 

i. File menu 

The File menu (shown on the right) allows opening and saving 

GDML files and also various import and export options. An option 

also permits opening recent files. Finally the exit option enables 

leaving the application. 

Please note that EDGE can only load one file at a time. When open-

ing a GDML file, if there are unsaved modifications, the application 

will propose to save this work before replacing it by the new opened 

file. 

In its trial version, EDGE does not allow exporting or saving to GDML. 

NB: EDGE tries to load all files, even if there are inconsistencies. For example, if a file contains two 

solids with the same name, EDGE will only consider the last element with this name and inform about 

this issue and the chosen resolution.  

ii. Tools menu 

The Tools menu (shown on the right) offers various tools and 

shortcuts. From here, you can access the preferences panel pre-

sented in section 4. The console log is displaying various mes-

sages from the application such as errors and warnings. 

With this menu, it is also possible to apply corrective patch to 

EDGE or install new feature plugin. To do so, click on the correct 

item and a file choose will appear and asks where the patch/plugin 

is located. Once installed, it is recommended to restart the appli-

cation.  

This menu also offers access to various tools and model computation operations which are 

described in more details in section 5.5. 

iii. Other menus 

The Views menu allows switching from one of the perspectives presented earlier to another. 

The Help menu is useful to access this user manual directly from within the application. This 

menu also offers the about screen, resuming information about the software.  

3.3.2. General Toolbar 

The left part of this toolbar allows the user, thanks to three buttons, to access the Preferences, 

presented in section 4, and to easily open and save a file without opening the File menu pre-

sented in 3.3.1. 
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The right part of this toolbar presents four buttons allowing the user to switch between the four 

main perspectives of EDGE: the Geometry edition (visible on Figure 8, see section 5), the 

Material definition (see section 6), the Material affectation one (see section 7 for more infor-

mation) and finally the GDML File perspective (see section 8). 
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4. Preferences 

The Preferences dialog box allows the setting of the applications options. For each option, a 

ẮReset to defaultắ button allows switching back to the initial value. 

At the first launch of the application, the Preferences dialog box is shown and enables the user 

to change the default parameters right away. 

4.1. GDML default material preferences  

 

Figure 4: GDML default materials preferences  

The first tab Ầ shown on Figure 4 Ầ offers options concerning the default GDML materials 

used in the application. Indeed, when a new shape is created in EDGE, a default material is 

assigned to it that can be changed later on in the Material Assignment perspective (see section 

7 page 42).  Here, it is possible to select which material will be assigned to the world element 

and to other elements. The selection can be performed from within the EDGE default materials 

list and the Geant4 default materials list. 
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4.2. GDML writer preferences  

 

Figure 5: GDML writer preferences  

The second tab, shown on Figure 5, sets parameters for the GDML writer: 

¶ Write default values: if this option is selected, the values for optional fields will be 

written even if they equal to the default value Ầ it is the case for example for the posi-

tion and orientation (0 is the default value); 

¶ Write default units: if this option is selected, the units will always be specified inside 

the GDML file even if they equal to the GDML default units (mm for lengths and radians 

for angles); 

¶ Write non-used user-defined materials: if this option is selected and that the user 

has defined materials which are not assigned to a geometric shape, those materials 

will be stored in the GDML file anyway; 

¶ Save chosen colours to GDML file: if this option is selected, the colours chosen in 

the Geometry panel will be saved to the GDML file using the <auxiliar y>  tag, and 

then when loading the file the colours will be the same. Be careful, the content of the 

<auxiliary> tag is not interpreted by the Geant4 numerical kernel. This tag is usually 

properly treated by the client code as explained in the GDML user manual [RD9] 

¶ Validation mechanism in GDML file: Choose the reference to the GDML file validator 

(.xsd) defined in the GDML file after the save action in EDGE. The choices are: 

o online (the validation process requires an internet connection when the file in 

other tools is loaded); 

o local (the validation is made locally with a validator file embedded on the local 

computer. The saved GDML file can only be used on this computer as long as 

the software is not moved); 

o none (no reference to a GDML file validator is written, then no validation will be 

processed when the GDML file will be used by other tools). 
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4.3. General preferences  

 

Figure 6: General preferences  

The third tab offers more general usability preferences, as shown on Figure 6: 

¶ Default 3D view shape opacity : sets the default opacity used when adding a new 

shape to the 3D view. Indeed, a colour is automatically chosen for every new shape 

and this setting will choose the opacity for this colour. The value 0.0 is fully transparent 

while the value 1.0 is fully opaque. Please note that this setting will not change the 

opacity of the shapes already displayed in the 3D view; 

¶ Maximum number of recent files : this option controls the number of recent files 

stored by EDGE and accessible in the Open recentẸ menu.  

¶ Enable dragẫnẫdrop: enables the possibility to move the elements in the Shapes tree 

using drag and drop gesture with the mouse. It facilitates the modification of the hier-

archy Ầ to avoid unwanted modifications, this option is disabled by default;  

¶ Display ẮAdd new shapeắ labels: display shortcut labels in the shapes tree of the 

Geometry Edition perspective. These labels help to gain time to add new shape but 

this option is disabled by default to gain cleanliness. 
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4.4. System preferences 

  

Figure 7: System options 

The last tab sets preferences for the system, as shown on Figure 7. The user can choose: 

¶ Application cache directory: by clicking on the ẮBrowseắ button, the user can choose 

the path where the application stores its temporary files. It may be useful to change this 

setting if you do not have write access to your temporary folder (by default EDGE uses 

the operating system default temporary folder); 

¶ Maximum allocated memory: the user can choose the value and unit (Mo or Go) of 

the available memory for EDGE. It can be useful to increase this value when loading 

very big files, without exceeding the system maximum capabilities. 

NB: As mentioned in section 3.2. iii, this option will not be taken into account when launching 

EDGE with the EDGE.exe on Windows systems. 
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5. Geometry Edition 

The Geometry perspective is the main perspective of EDGE since it allows the creation and 

the edition of geometrical elements. 

5.1. The Geometry edition perspective  

It is the main perspective of EDGE displayed by default at the launching. It has three main 

panels to edit the geometry, as shows Figure 8: 

¶  Shapes Tree panel, to visualise and edit the list of geometric shapes; 

¶  Properties panel, to edit the properties of the currently selected shape; 

¶  3D Viewer panel, present only for the geometrical edition and material affectation 

perspectives, provides a 3D view of the modelled system.  

These panels, as well as the 3D View panel, can be moved, detached or maximized at the 

userẫs liking using the buttons on their top right corner. 

 

Figure 8: EDGE geometry edition view 

  

1 

2 
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1 

2 
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5.1.1. Shapes tree 

The Shapes tree lists all the shapes currently defined in the geometrical model and displayed 

in the 3D scene. It also shows the hierarchy of the shapes. The shape(s) currently selected is 

(are) highlighted in the 3D view on the right with a red box. It is also possible to move one 

geometry element and all its children elements to another logical location in the geometry tree. 

This feature is available only if the dragẫnẫdrop option has been enabled in the Preferences, 

see section 4. 

On the right of each shape, a click on the coloured box opens a dialog that allows changing 

the colour of the shape in the 3D view. It is also possible to change the transparency of the 

selected element in this dialog box, as shown on Figure 9. A checkbox on the right controls 

the visibility of the object in the 3D view.  

 

Figure 9: Colour changing dialog box 

On top of the tree, five buttons are used to control the shapes:  

¶ The three buttons on the left side allow adding, duplicating and/or removing shapes. 

The first one ( ) opens a dialog box to add a new shape to the tree (more details in 

section 5.4.1). The second one ( ) duplicates the selected shape(s) and the third 

one ( ) deletes all the shapes currently selected in the tree.  

¶ The two buttons on the right side allow performing actions on the currently selected 

shape(s). The first one ( ) opens a dialog box to apply a transformation to all the 

elements currently selected (see section 5.4). The second one ( ) offers the possi-

bility to use a clipping filter. This button triggers the apparition of a dialog box allowing 

the user to set the parameters of the clipping filter, see Figure 10. This filter performs 

a cut in the geometry to view more precisely the inner geometry of the modelled system. 
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The clipping is set with the coordinates of a centre point and a normal direction. It will 

keep the geometric representation of the selected element in the half-space defined by 

this point and the normal. To get a more interactive setting, you can select the ẮDisplay 

3D control widgetắ that will display an interactive control in the 3D view to change the 

clipping. These 3D controls of the filter are materialised by a sphere (representing the 

centre of the clipping operation) and an axis with two arrows (representing the normal 

direction), see Figure 10. 

    

Figure 10: Clipping filter applied on Raspberry Pi Zero housing with the 3D control 

widget enabled (left) and clipping control pane (right) 

5.1.2. Properties panel 

This panel shows the properties of the shape currently selected in the Shapes tree. It shows 

properties only if there is one Ầ and only one Ầ shape selected. Depending on the shape 

selected, the properties displayed change accordingly.  

The user can thus define the dimensions of the shape. For each shape, parameters vary and 

explanatory schemes are presented in section 5.2. These pictures are also available in the 

software by clicking on the ẮHelpắ button ( ). 

This panel shows also fields to choose the position and orientation of the object and the unit 

of measure. The unit for parameters, positions and rotations can be changed and an automatic 

conversion of values is proposed. The default units are millimetres (mm) for lengths and radi-

ans (rad) for angles. 
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i. Thickness parameter and Boolean operations 

Some elements Ầ such as boxes, ellipsoids, orbs, parallelepipeds and trapezoids Ầ have an additional 

useful parameter (not present in GDML) called thickness. If a shape has a thickness defined (different 

from 0), then the export of this shape will be done using Boolean operations (a subtraction between the 

outer element and the inner element). It allows the user to gain time for this kind of operations.  

This kind of shape can be very useful during the definition 

of radiation analysis. The user shall be aware that this thick-

ness value is not a GDML parameter, which means that set-

ting this parameter to a value different from zero will result, 

in the GDML file, to the corresponding Boolean operation. 

The little warning sign ( ) next to the name of this parame-

ter is present to remind the user of this. 

If an EDGE file containing a shape with a defined thickness 

(different from 0) has been saved and is then loaded again, 

the user must note that the concerned shape will be dis-

played as Boolean operations. It means that when the user 

will click on the corresponding shape, it will be displayed as 

a Boolean operation and the user will not be able to edit it 

and change its dimensions, position and rotation parame-

ters. 

5.1.3. 3D View 

The 3D view is showing in real-time the product of the GDML model. It is possible to interact 

with the view using the mouse to control it: 

¶ Left click (hold) and movement: rotate the scene; 

¶ Wheel (hold) and movement: translate the scene; 

¶ Right click (hold) and movement: zoom; 

Or the keyboard: 

¶ ẮRắ resets the view and shows all the shapes of the scene; 

¶ ẮIắ to zoom in; 

¶ ẮOắ to zoom out;   

¶ ẮWắ displays the shapes as wireframes; 

¶ ẮSắ displays the shapes as solid; 

¶ The up/down/left/right arrows rotate the scene.  
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The buttons at the top of the view also facilitate its handling: 

¶  resets the view and shows all the shapes of the scene (ẮRắ key shortcut); 

¶  aligns the view along +X axis; 

¶  aligns the view along -X axis; 

¶  aligns the view along +Y axis; 

¶  aligns the view along ấY axis; 

¶  aligns the view along +Z axis; 

¶  aligns the view along -Z axis. 

NB: Sometimes, at the launch of the software, the 3D view is not correctly initialised. To refresh it, 

change perspective to another one and come back to the initial perspective, the 3D view is now correctly 

initialised. It can also happen when using several screen and moving the application from one screen 

to another one. 

On top of the 3D view, a drop-down menu allows the user to choose a model operation to 

launch (cf. section 5.5). These operations are also available through the Tools menu presented 

in section 3.3.1.i. 

On the bottom of the 3D view, an information bar displays useful 

information about the current selection: the number of selected 

elements as well as the size and the position of the bounding 

box Ầ the red box around selected elements. It is possible to 

click on the number of selected elements to display a list of the 

currently selected elements as shown on Figure 11. 

5.2. Available geometric shapes 

EDGE handles several primitive geometric shapes as shown on Figure 12. Other kind of 

shapes are also supported and presented in section 5.3. 

 

Figure 12: Available shapes 

 

The figures from Figure 13 to Figure 24 on the following pages present the parameters of all 

the shapes handled by EDGE. For concerned elements, the parameter thickness is explained.  

Figure 11: List of se-

lected elements  
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Figure 13: Box parameters 

 

Figure 14: Cone parameters 

 

 

Figure 15: Ellipsoid parameters 

 

Figure 16: Elliptical cone parameters 
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Figure 17: Elliptical tube parameters 

 

Figure 18: General trapezoid parameters 

 

 

 

Figure 19: Orb parameters 

 

Figure 20: Paraboloid parameters 
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Figure 21: Parallelepiped parameters  

 

Figure 22: Sphere parameters 

 

Figure 23: Trapezoid parameters 

 

Figure 24: Tube parameters 

  



 EDGE 2.4.2 

User Manual 
PAGE 

25/47 

 

Status: final Date: 19/03/2019  

 

5.3. Other shapes available  

5.3.1. Tessellated Solid 

Solids with complex geometries can be constructed by importing tessellated surfaces, includ-

ing initially B-Rep based models. Numerous formats are supported (.geo, mesh file, STEP AP 

203 ấ 214 ...). Those tessellated surfaces are converted into an equivalent GDML tessellated 

solid object. 

Please notice that the imported tessellated surface must imperatively be a close surface. 

EDGE displays a warning message to the user if it is not the case.  

 

Figure 25: Example of an imported tessellated solid 

5.3.2. Assemblies 

In EDGE, the user has the possibility to handle Ắassemblyắ elements. Those elements are 

grouping several shapes without being attached to a geometric shape. 
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5.3.3. GDML file 

EDGE also allows importing all the geometry concepts from another GDML file and including 

them as a child of the currently selected element. This option can be very useful if users want 

to check the position of a specific subsystem (defined in the imported GDML file) in the whole 

system (main GDML file). An example is shown on Figure 26. 

 

Figure 26: Example of import of GDML file 

5.4. Edition of the geometry 

5.4.1. Creating/adding a new shape 

The user has first to create a Ắworldắ shape that will include all subsequent shapes. The posi-

tion (0, 0, 0) corresponds to the barycentre of this world shape. Once this is done, it is possible 

to start the construction of the desired object. 

NB: Even if technically GDML allows creating a world smaller than the final object, it is not recom-

mended. The world shape typically corresponds to the computational domain of numerous of simulation 

software using GDML files in input. And most of these tools will not work properly nor give relevant 

results if the world shape does not encapsulate all other elements. The relevant definition of the world 

shape remains on the responsibility of the user and with respect to the final targeted application.  










































